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1 Automation Engine QuickStart for Labels

1.  Copyright Notice
© Copyright 2019 Esko Software BVBA, Gent, Belgium

All rights reserved. This material, information and instructions for use contained herein are
the property of Esko Software BVBA. The material, information and instructions are provided
on an AS IS basis without warranty of any kind. There are no warranties granted or extended
by this document. Furthermore Esko Software BVBA does not warrant, guarantee or make any
representations regarding the use, or the results of the use of the software or the information
contained herein. Esko Software BVBA shall not be liable for any direct, indirect, consequential
or incidental damages arising out of the use or inability to use the software or the information
contained herein.

The information contained herein is subject to change without notice. Revisions may be issued
from time to time to advise of such changes and/or additions.

No part of this document may be reproduced, stored in a data base or retrieval system,
or published, in any form or in any way, electronically, mechanically, by print, photoprint,
microfilm or any other means without prior written permission from Esko Software BVBA.

This document supersedes all previous dated versions.

PANTONE
®
 Colors displayed in the software application or in the user documentation may

not match PANTONE-identified standards. Consult current PANTONE Color Publications for
accurate color. PANTONE

®
 and other Pantone trademarks are the property of Pantone LLC. ©

Pantone LLC, 2015

Pantone is the copyright owner of color data and/or software which are licensed to Esko to
distribute for use only in combination with Studio Visualizer. PANTONE Color Data and/or
Software shall not be copied onto another disk or into memory unless as part of the execution
of Studio Visualizer.

This software is based in part on the work of the Independent JPEG Group.

Portions of this software are copyright © 1996-2002 The FreeType Project (www.freetype.org).
All rights reserved.

Portions of this software are copyright 2006 Feeling Software, copyright 2005-2006 Autodesk
Media Entertainment.

Portions of this software are copyright ©1998-2003 Daniel Veillard. All rights reserved.

Portions of this software are copyright ©1999-2006 The Botan Project. All rights reserved.

Part of the software embedded in this product is gSOAP software. Portions created by gSOAP
are Copyright ©2001-2004 Robert A. van Engelen, Genivia inc. All rights reserved.

Portions of this software are copyright ©1998-2008 The OpenSSL Project and ©1995-1998 Eric
Young (eay@cryptsoft.com). All rights reserved.

This product includes software developed by the Apache Software Foundation (http://
www.apache.org/).

Adobe, the Adobe logo, Acrobat, the Acrobat logo, Adobe Creative Suite, Illustrator, InDesign,
PDF, Photoshop, PostScript, XMP and the Powered by XMP logo are either registered
trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other
countries.
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Microsoft and the Microsoft logo are registered trademarks of Microsoft Corporation in the
United States and other countries.

SolidWorks is a registered trademark of SolidWorks Corporation.

Portions of this software are owned by Spatial Corp. 1986 2003. All Rights Reserved.

JDF and the JDF logo are trademarks of the CIP4 Organisation. Copyright 2001 The International
Cooperation for the Integration of Processes in Prepress, Press and Postpress (CIP4). All rights
reserved.

The Esko software contains the RSA Data Security, Inc. MD5 Message-Digest Algorithm.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun
Microsystems in the U.S. and other countries.

Part of this software uses technology by Best Color Technology (EFI). EFI and Bestcolor are
registered trademarks of Electronics For Imaging GmbH in the U.S. Patent and Trademark
Office.

Contains PowerNest library Copyrighted and Licensed by Alma, 2005 – 2007.

Part of this software uses technology by Global Vision. ArtProof and ScanProof are registered
trademarks of Global Vision Inc.

Part of this software uses technology by Qoppa Software. Copyright © 2002-Present. All Rights
Reserved.

All other product names are trademarks or registered trademarks of their respective owners.

Correspondence regarding this publication should be forwarded to:

Esko Software BVBA

Kortrijksesteenweg 1095

B – 9051 Gent

info.eur@esko.com
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2.  eLearning Modules
• All eLearning modules serve as initial training and can be accessed from within the browser

client.
• This manual adds more details, answers FAQs and more.

All eLearning modules are available (in English) on http://docs.esko.com/docs/en-us/
automationengine/18.1/quickstartguide/home.html.

Note:  Change the language setting in the application to see if a translation exists in the
language you selected there.
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3.  Installation

3.1.  Copyright Notice
© Copyright 2019 Esko Software BVBA, Gent, Belgium

All rights reserved. This material, information and instructions for use contained herein are
the property of Esko Software BVBA. The material, information and instructions are provided
on an AS IS basis without warranty of any kind. There are no warranties granted or extended
by this document. Furthermore Esko Software BVBA does not warrant, guarantee or make any
representations regarding the use, or the results of the use of the software or the information
contained herein. Esko Software BVBA shall not be liable for any direct, indirect, consequential
or incidental damages arising out of the use or inability to use the software or the information
contained herein.

The information contained herein is subject to change without notice. Revisions may be issued
from time to time to advise of such changes and/or additions.

No part of this document may be reproduced, stored in a data base or retrieval system,
or published, in any form or in any way, electronically, mechanically, by print, photoprint,
microfilm or any other means without prior written permission from Esko Software BVBA.

This document supersedes all previous dated versions.

PANTONE
®
 Colors displayed in the software application or in the user documentation may

not match PANTONE-identified standards. Consult current PANTONE Color Publications for
accurate color. PANTONE

®
 and other Pantone trademarks are the property of Pantone LLC. ©

Pantone LLC, 2015

Pantone is the copyright owner of color data and/or software which are licensed to Esko to
distribute for use only in combination with Studio Visualizer. PANTONE Color Data and/or
Software shall not be copied onto another disk or into memory unless as part of the execution
of Studio Visualizer.

This software is based in part on the work of the Independent JPEG Group.

Portions of this software are copyright © 1996-2002 The FreeType Project (www.freetype.org).
All rights reserved.

Portions of this software are copyright 2006 Feeling Software, copyright 2005-2006 Autodesk
Media Entertainment.

Portions of this software are copyright ©1998-2003 Daniel Veillard. All rights reserved.

Portions of this software are copyright ©1999-2006 The Botan Project. All rights reserved.

Part of the software embedded in this product is gSOAP software. Portions created by gSOAP
are Copyright ©2001-2004 Robert A. van Engelen, Genivia inc. All rights reserved.

Portions of this software are copyright ©1998-2008 The OpenSSL Project and ©1995-1998 Eric
Young (eay@cryptsoft.com). All rights reserved.

This product includes software developed by the Apache Software Foundation (http://
www.apache.org/).
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Adobe, the Adobe logo, Acrobat, the Acrobat logo, Adobe Creative Suite, Illustrator, InDesign,
PDF, Photoshop, PostScript, XMP and the Powered by XMP logo are either registered
trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other
countries.

Microsoft and the Microsoft logo are registered trademarks of Microsoft Corporation in the
United States and other countries.

SolidWorks is a registered trademark of SolidWorks Corporation.

Portions of this software are owned by Spatial Corp. 1986 2003. All Rights Reserved.

JDF and the JDF logo are trademarks of the CIP4 Organisation. Copyright 2001 The International
Cooperation for the Integration of Processes in Prepress, Press and Postpress (CIP4). All rights
reserved.

The Esko software contains the RSA Data Security, Inc. MD5 Message-Digest Algorithm.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun
Microsystems in the U.S. and other countries.

Part of this software uses technology by Best Color Technology (EFI). EFI and Bestcolor are
registered trademarks of Electronics For Imaging GmbH in the U.S. Patent and Trademark
Office.

Contains PowerNest library Copyrighted and Licensed by Alma, 2005 – 2007.

Part of this software uses technology by Global Vision. ArtProof and ScanProof are registered
trademarks of Global Vision Inc.

Part of this software uses technology by Qoppa Software. Copyright © 2002-Present. All Rights
Reserved.

All other product names are trademarks or registered trademarks of their respective owners.

Correspondence regarding this publication should be forwarded to:

Esko Software BVBA

Kortrijksesteenweg 1095

B – 9051 Gent

info.eur@esko.com

3.2.  How to Install Automation Engine 18.1

Note:  This information is not different from the installation guide of AE 18.0

3.2.1.  Before installing Automation Engine 18.1

Before you install Automation Engine 18.1 on your system, prepare or check these topics:

• Check the document Pre-Installation IT Requirements Guide, which is also a chapter in the
Automation Engine Complete Manual, available on http://help.esko.com/products/Automation
%20Engine.
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3Automation Engine QuickStart for Labels

• Install Automation Engine 18.1 on a "clean" system, where no Esko software has been
installed yet. If any other version of Automation Engine was installed already, see the
section How to Upgrade to Automation Engine 18.1 on page 16.

• You will need the DVD: "Automation Engine 18.1 installation".

Note:  If you downloaded the software from MySoftware.esko.com, you will need to mount the
corresponding .iso files as virtual DVD, or unpack the .iso files first.

Note:  Make sure you are aware which type of installation you are doing. This is explained in
the next page, in Types of Installations.

• Your Windows operating system must be a "Server" type

Note:  Windows Server 2008 R2 is only supported for doing an upgrade from a previous
version of Automation Engine. A new install on that OS is no longer supported.

• Your Windows operating system must be a 64 bit.
• You need to have Administrator privileges.
• You need internet access from that server computer.
• Your computer must meet the minimum requirements for the installation, as described on

www.esko.com/systemrequirements.
• Make sure your anti-virus software is not blocking the installation or configuration.
• Microsoft SQL Server 2005, 2008 and 2008 R2 are no longer supported. From AE 16.1

on, the Server Admin web page will alert you to that when you run the Server Checks >
Databases.

• Automation Engine can use a full SQL Server instead of the default installed Express
edition. Learn more about pro's and con's on this page of the chapter "Pre-Install IT
Requirements Guide".

• You may not have an IIS web server installed on your system.
• You need software licenses for Automation Engine: a product key file. If you do not have a

product key file yet, contact Esko Customer Support.

3.2.2.  Types of Installations

The installation procedure will ask you which type of installation you want to do.

Attention:  Before making these decisions, first learn about the possibilities of different
database servers on this page in the chapter Pre-Install IT Requirements Guide.

• Standard Installation

• Automation Engine Master, Device Manager, QuickStart or WebCenter OBGE.

These installations also install the default supplied Microsoft SQL Express edition on the
Automation Engine server.

Note:  A Device Manager is a server software limited to communicating with CDI's or
Kongsberg table devices. The QuickStart deployment brings a fixed template workflow
and offers a browser interface. A WebCenter OBGE (On Board Graphics Engine) is a
limited Automation Engine used to calculate the view files for an Esko WebCenter. This
will typically be installed on the WebCenter Application Server.

• Automation Engine Assistant.
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3 Automation Engine QuickStart for Labels

This installs an Automation Engine that you can (later) configure to be used as an
Automation Engine Assistant. This option will not install a Microsoft SQL Express server.

• Installation for use with an existing Microsoft SQL Server

• Automation Engine Master, Device Manager or WebCenter OBGE.

These installations will use a remote SQL Server that is already available in the network.
They will not install a Microsoft SQL Express server. For example: when you are installing
an OBGE and you want it to use the SQL Server already used by your (full) WebCenter.

Attention:  This type of installation includes an embedded mini database server
engine. This embedded engine is not fit for production ; it is a temporary setup
until you have chosen a different supported database engine.

3.2.3.  How to perform the Automation Engine 18.1 System Readiness
Check

Before you install Automation Engine 18.1, a System Readiness Check is required. This checks
whether the operating system is suited for installing and running this Esko product.

1. On the DVD, in the section Software installation, click the type of installation that fits your
purpose (as explained in Types of Installations on page 9).

2. In the section Installation, under Instructions, click Run the Automation Engine
Readiness Check.

3. At the end of the Readiness Check, read the resulting messages carefully.
4. If the Readiness Check resulted in any problem, correct it before proceeding.
5. Click Exit.
6. Proceed to install the Esko License Server.

3.2.4.  How to install the Esko License Server

Use of the Automation Engine software is protected by licenses. These licenses are distributed
as a product key file (in .html). To import the licenses into the Esko License Server, the product
keys in the product key file must be activated using the Activate Server Licenses tool.

You need:

• A product key file for the Automation Engine 18.1 product components. If you do not have a
product key file yet, contact Esko Customer Support.

• Internet access, to activate the licenses.

• An Esko ID in order to activate the licenses. Get one at http://www.esko.com/licensing/
CreateAccount.

Follow these steps:

1. On the DVD, in the section Installation, under Instructions, click Install the License
Server Components.

2. Install the Esko License Server by clicking Install the Network License Manager.
3. Follow the instructions of the installation wizard.
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3Automation Engine QuickStart for Labels

4. When the installation is finished, click Network License manager > Network License
Manager.

5. Local License Manager: If you want to activate the license on your local computer
(recommended in case of an Automation Engine Master), follow these steps:
a) In the Esko Network License Manager, click Activate.
b) Follow the instructions of the Activate License Wizard.
c) When asked how to activate the licenses, choose on-line activation.
d) When asked about the product keys, choose I have a file containing one or more

product keys.
e) Click Browse to select the product key file.
f) When asked, fill in your Account Name and Password.
g) Click Finish.

The licensed products you can use are now visible in the Esko License Server.
h) Close the License Manager and click Go back in the top-right corner of the page to

return to the  Installation page.
6. Remote License Manager: If you are using a remote license manager (typical in case of an

Automation Engine Assistant), you only need to indicate where it is. Follow these steps:
a) In the Network License manager, open the Help menu and click License client

configuration.
b) In the License Client Configuration window, in the field "computer name of the License

server" type in the host name of the license server and click Apply.
c) Click Exit.

7. Now continue by clicking on Install the prerequisite components.

3.2.5.  How to install the Automation Engine Prerequisite
Components

Depending on the products to be installed on this particular system, various components are
required for installation. The installation wizard for these prerequisite components checks the
licenses, lists the prerequisite components to install, requests confirmation for installation and
then installs the required components.

The installation wizard installs the following components:

• Microsoft Visual Studio Redistributables
• Esko CAD-X components for Standard and Enterprise Editions.

Note:  Do not install the CAD-X components when ArtiosCAD is already installed on that
server.

• Database Engine for the Automation Engine components (if you choose a Standard
Automation Engine Installation)

Follow these steps:

1. On the DVD, in the section installation, click Install the Prerequisites Components.
2. Follow the instructions of the installation wizard.
3. When you choose a Standard installation, when asked to enter a password for the SQL

Server, click Use Default to use the default sa password. Or you can enter a Password,
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confirm it and click Use Password to use a different password, for example because of
"Strong Password" requirements.

Note:  During the pre-installation of the Database Engine for Automation Engine, the
Microsoft .NET Framework 4.6.1 will be installed. You may get a warning saying that the
system needs to be rebooted, followed by a fatal error "The SQL Server instance is not
installed". If this happens, reboot your server and install the prerequisites again.

4. The installation wizard will ask you to close all Esko applications. Click Yes when asked
Ready to continue?

5. Follow the instructions of the installation wizard.
6. Click Continue. Click Yes in the Installshield Wizard Complete message window.
7. Depending on your activated licenses, the Automation Engine Prerequisite Components

First Installation process may ask you separately about the CAD-X component installation
for both the Standard Edition component and the Enterprise Edition component. In both
cases, click Yes when asked Ready to continue?.

8. Follow the instructions of the installation wizard.
9. Click Exit.

You will be redirected to the installation page to continue with the next step.

3.2.6.  How to install Automation Engine 18.1

1. After running the System Readiness Check and installing the License Server
Components, when all prerequisites are fulfilled, you can start the installation.

2. Click the Install Automation Engine 18.1 link on the installation page.
The Automation Engine 18.1 Software Installation wizard will open up.

3. Follow the instructions of the installation wizard.
4. Read the Software and Data license agreement carefully and select Yes, I accept the

license agreement.
5. When asked to select the products to install on this system, select Automation Engine

18.1.
The group Common Components cannot be deselected and will be installed on all
systems.

6. Select the Destination Folder for the chosen products or accept the defaults.
7. Follow the instructions of the installation wizard.
8. At the end of the installation, click Finish.

The pre-installation task checks the password complexity rules and domain policies. If the
default password for the BGSYSTEM user does not fulfill the requirements, a pop-up dialog
requests a password.

During installation, only a BGSYSTEM user is created. This user will be used as Automation
Engine System Account (you can choose to change it later using the System Account page).

A clean installation ends with two empty user groups: BGUSERS and BGADMIN.
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Note:  Learn more about Users and Groups in the separate chapter Pre-Install IT Requirements
Guide.

After installation of Automation Engine, a shortcut named "Automation Engine Client Apps"
is put on the desktop of the server computer.

Double-click this shortcut to open the Automation Engine Client Apps web page in your
default browser.

This page describes the two types of Client Applications:

• Desktop Client Applications (Pilot or Shuttle): These need to be installed on each
workstation where you want to use Automation Engine.

• Browser based Client Applications: These run inside the browser and do not need to be
installed.

3.2.7.  How to install Pilot or Shuttle

The Automation Engine Client software is distributed via the Server Web Page.

Note:  Whenever your Automation Engine Server is updated, the Pilot or Shuttle will request
an update. The automatic update mechanism alerts you to update when hot-fixes and minor
version updates (for example 18.1 to 18.1.1) are available. If you are doing a major version
upgrade (for example: 18 to 18.1), you need to re-install the client applications (and when
ready, remove the old ones).

Note:  Installing the Pilot is shown in detail in one of the eLearning modules listed on https://
www.esko.com/en/Support/Product?id=Automation%20Engine (example on Windows).

1. Open your web browser and go to http://servername:9999/ or  http://servername,
where servername is the name of the computer running Automation Engine server
software.

2. The first time you install one of the client applications, you will be asked to create an
Administrator account.
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Once you have created the administrator account, you will be directed to either

• the tab "Client Apps" where you can download Client Applications if you did install a
Standard Automation Engine.

• or to the Create Automation Engine Database page if you did install an Automation
Engine Master for use with an existing Microsoft SQL Server. This is where you then
need to configure and create your Automation Engine databases.

In the Create Automation Engine Database window, select your Microsoft SQL Server
and Instance name, type in the sa password and type in the Database folder and either

• click create to start the automatic creation and configuration of the databases,

• or, if you want to create and configure the databases manually, click Continue using
embedded databases.

Attention:  It is not supported to use Automation Engine with embedded
databases in a production environment.

Learn more about creating databases for Automation Engine in Creating a Database.
Learn more about configuring an Automation Engine database in Automation Engine
Database.

After creation and configuration of the databases, you will be redirected to the Main
page of the tab "Client Apps", where you can download the client applications.

3. Click Download.
4. Start the installation by double-clicking the downloaded executable.
5. Follow the instructions of the installation wizard.
6. Read the Software and Data license agreement carefully and select Yes, I accept the

license agreement.
7. Follow the instructions of the installation wizard.
8. At the end of the installation, click Finish.
9. Double-click the Automation Engine Pilot or Shuttle shortcut on the desktop.
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10.Fill in the User name, Password and Server Name. You can here use the administrator
account that you created earlier. Click OK.
The Pilot or Shuttle will start up.

Initial configuration (Pilot)
After an initial installation, you typically want to configure a minimal setup that includes:

• Containers. Define which existing or new data shares contain the data that Automation
Engine will be able to work with.

Learn more in Containers.

Note:  An initial installation already creates an ExampleJobContainer on the disk where
you installed the server software.

• Users. An initial installation creates 2 user groups and some default users.

Learn more about creating (domain) users and setting their Access Rights in the Users View
and Tool.

• Task Cleanup Rules: A new installation will also have created a default Task Cleanup rules.

Note:  A new installation will also have created a default Task Cleanup rules. Learn more
about changing or adding such rules in Task Cleanup Rules.

• Temporary data.

Automation Engine creates a lot of temporary data on the folder defined by the Windows
variable %BG_TMP. The folder where this variable is set to should be a fast drive with >50GB
free space.

By default this is installed on the same drive as where the software is installed. In case that
disk threatens to fill up, we advise to redirect that variable to another place. Learn how to
do this in this KB article.

3.2.8.  How to open the browser client

To open the Automation Engine browser client, open your web browser on your workstation
and go to http://servername:9000 , where servername is the name of the computer
running Automation Engine server software.

Note:  Configuring the Automation Engine Browser is shown in one of the eLearning
modules. This eLearning module is a summary of what is described in the chapter 'Post-Install
Configuration' in this manual.

Initial configuration (Browser)
After an initial installation, you typically want to configure a minimal setup that includes:

• Containers
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At first start up in the browser, you will be asked to define a Data Container. Define which
existing or new data shares contain the data that Automation Engine will be able to work
with.

Note:  An initial installation already creates an ExampleJobContainer on the disk where
you installed the server software.

• Users

At first start up in the browser, you will also be asked to create an Admin user.

Note:  The others can later be created via the menu Admin >  Users.

• Task Cleanup Rules

The product preparation tasks that run on the server will be cleaned up automatically by
default 'Task Cleanup rules'.

• Temporary data.

Automation Engine creates a lot of temporary data on the folder defined by the Windows
variable %BG_TMP. The folder where this variable is set to should be a fast drive with >50GB
free space.

By default this is installed on the same drive as where the software is installed. In case that
disk threatens to fill up, we advise to redirect that variable to another place. Learn how to
do this in this KB article.

3.3.  How to Create a full Backup of Automation Engine
18.1

You can create backups with the tools available in Server Admin section of the Automation
Engine Server Web Page.

These tools are documented in the page Backup of the chapter Automation Engine Server
Management.

3.4.  How to Upgrade to Automation Engine 18.1
You need to upgrade to Automation Engine 18.1 in the following order:

1. Create a backup of your current Automation Engine.
2. Perform the System Readiness Check.
3. Upgrade the License Manager.
4. Upgrade the prerequisite components.

16

https://wiki.esko.com/display/KBAS/KB152240417%3A+Automation+Engine+-+How+to+move+temp+folder


3Automation Engine QuickStart for Labels

5. Upgrade the Automation Engine software.

3.4.1.  Before Upgrading to Automation Engine 18.1

Before you upgrade to Automation Engine 18.1, prepare the following:

• Check the document Pre-Install IT Requirements Guide, a separate chapter in the Automation
Engine complete manual.

• You will need the DVD "Automation Engine 18.1 installation".

Note:  If you downloaded the software from MySoftware.esko.com, you will need to mount the
corresponding .iso file as virtual DVD.

• You must have a working version of Automation Engine 14 or higher.
• Your computer must meet the minimum requirements for the installation, as described on

www.esko.com/en/SystemRequirements.

Attention:  Make sure to check that the version of SQL Server that your previous AE
version was using as database server is still supported.

• You need a product key file for the upgrade (every new major version requires a new license
set). If you do not have a product key file yet, contact Esko Customer Support.

• Use Status Overview to make sure no more users are connected or using the system.
• The upgrade will check if you are still using tasks that have become Outdated in the version

that you are installing. If any are found, you will have the chance to abort the installation.
Learn more about such tasks in Outdated and Soon Outdated Tasks in v18.1.
 

 
• Reboot the server before upgrading Automation Engine.

3.4.2.  How to Create a Backup of your Current Automation Engine

As an extra security measure, we advise to create a backup of your current version of
Automation Engine before upgrading.

• When your current version is 14.0 or higher, make a backup as described in Backup (in the
chapter AE Server Management).
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• When your current version is 12.x,

• first make a backup as described in Backup,

• then upgrade to either 14.x or 16.0,

• then again make a backup and then upgrade to 18.x

• When your version is 10 or lower, contact Esko Customer Support.

3.4.3.  How to Perform the Automation Engine 18.1 System Readiness
Check

1. On the DVD, in the section Installation, under Instructions, click Run the Automation
Engine Readiness Check.
Learn more in How to perform the Automation Engine 18.1 System Readiness Check on page
10.

2. Proceed to install the Esko License Server. Click Install the License Server Components.

3.4.4.  How to upgrade the Esko License Server Components

The Automation Engine 18.1 product is protected by (new) licenses. These licenses are
distributed as a product key file (in .html). To import these new licenses into the Esko License
Server, you must first upgrade the Esko License Server components.

1. On the DVD, in the section Installation, click Install the License Server Components.
2. Follow the instructions of the installation wizard.

During the upgrade of the Network License Manager, the current Esko License Server will
be stopped temporary, during which the currently used licenses will be unavailable.

3. When the installation has finished, click Load the new licenses.
4. In the Load new licenses window, click Activate Server Licenses.
5. In the Network License Manager, click Activate.
6. Follow the instructions of the Activate License Wizard.
7. Select on-line activation.
8. Select I have a file containing one or more product keys.
9. Click Browse to select the product key file.
10.Fill in your Account Name and Password.
11.Click Finish.

The licenses for the upgraded products are now listed in the License Manager.
12.Close the License Manager and click Go back in the top-right corner of the page.
13.Click on Continue with the installation of the prerequisite components link.

3.4.5.  How to Upgrade the Prerequisite Components

Follow these steps to upgrade the Prerequisite Components:
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1. On the installation page, click Install the prerequisite components.
2. Follow the instructions of the installation wizard.
3. The installation wizard will ask you to close all Esko applications. Click Yes when asked

Ready to continue?
4. Follow the instructions of the installation wizard.
5. Click Continue. Click Yes in the Installshield Wizard Complete message window.
6. Automation Engine 18 Prerequisite Components Installation window will ask you about

CAD-X component installation, both 'Standard' and 'Enterprise'. Click Yes if ArtiosCAD is not
installed.

7. Follow the instructions of the installation wizard
8. Click Exit.

You will be redirected to the installation page to continue with the next step.

3.4.6.  How to upgrade Automation Engine software

After the upgrade of the prerequisite components, your system is ready to upgrade to
Automation Engine 18.1.

1. Click on the Install the Esko Software Platform 18.1 Automation Engine link on the
installation page.
The Automation Engine 18 Software Installation wizard will open up.

2. Follow the instructions of the installation wizard.
3. Read the Software and Data license agreement carefully and select Yes, I accept the

license agreement.
4. When asked to select the products to install on this system, select Automation Engine

18.1.
The group Common Components cannot be deselected and will be installed on all
systems.

5. Follow the instructions of the installation wizard.
6. Select the Destination Folder for the chosen products or accept the defaults.
7. During the pre-installation this question will appear "If you continue Automation

Engine <number-of-the-new-version> will be installed but it may not be
possible to return to <number-of-your-current-version>. Do you want to
continue the installation anyway?". Answer Yes.

8. Follow the instructions of the installation wizard.
9. At the end of the installation, click Finish.
10.Now install Automation Engine Client Applications. Learn more in How to install Pilot or

Shuttle on page 13.

3.5.  How to Upgrade onto a New Server Computer
These are the typical cases when you want to change the hardware (computer) of your
Automation Engine server:
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• You decide yourself that your server needs to be updated, usually for performance reasons.
• Your server no longer matches Esko's requirements for a Automation Engine server. A

typical case is when the Windows OS is no longer supported.

For example: Automation Engine 16 server is no longer supported on Windows 2003 or
Windows 2008 RTM 32/64bit. If your server runs Windows 2003 or Windows 2008 RTM
32/64bit , the hardware will also be too old by now to use it for such a vital production
tool. This means you will most probably not change the OS on that old server but install
Automation Engine on a new computer with a recent Windows OS. For a list of supported
OS, see http://www.esko.com/systemrequirements.

Attention:

• From Automation Engine 18.0 on, Windows 2008 R2 will no longer be supported
for new installations. However, it will still support Windows 2008 R2 for upgrades.

• A next version of Automation Engine will not support Windows 2008 R2 anymore.

Note:  Your new server can have a different name than the old server.

To move your Automation Engine server configuration to a new server, follow these main
steps:

1. Install Automation Engine on the new server

First you install Automation Engine on this 'virgin' new server. Follow the standard procedure
as described in How to Install Automation Engine 18.1 on page 8.

2. Backup your old server config, using the backup tool from your old
Automation Engine server

To get the configuration of your old server onto your new one, use the backup tool that is
offered in the Automation Engine Server Web Page of the old server (go to http://<name-
of-your-OLD-server>:9999/ and log in).

3. Restore that backup on your new Automation Engine.

To do this, use the Restore function as documented in Restore .

3.6.  How to Repair an Automation Engine Server
You typically need to repair a system when software program files got deleted or became
corrupt. For example a virus can cause such damage.

Note:  Only Automation Engine components of the same version as the one on the DVD can be
repaired/re-installed.

To repair the Automation Engine 18.1 software, proceed as follows:

1. Open the Automation Engine Software Installation window:
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• If you insert the distribution DVD into the DVD drive, or mount the corresponding .iso
file, the window appears automatically.

• If you unpacked a downloaded .iso file, or if the window doesn't open automatically,
double-click setup.exe in the root folder.

2. Select the installation language.
3. Click Proceed to the installation.
4. Click Repair / reinstall Automation Engine and Choose which component you want to

repair.

3.7.  How to Uninstall Automation Engine Server
software

When you uninstall a version of Automation Engine, only that Automation Engine server
software and the configuration of that version is removed. Also the "DeskPackContainer" is
removed. Resource files like color data, fonts or curves are not touched.

You can choose to uninstall the current version or an older version.

Note:  Although technically not required, it is a good standard practice to make a backup of
your current configuration before doing an uninstallation.
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3.8.  How to install the Configuration Manager
The Configuration Manager tool collects a lot of data regarding software versions, hot-fixes,
OS etc. This information can be useful for Esko customer service. It can also alert you on
expiring licenses.

Only install the Configuration Manager if there is no Configuration Manager active on your
network yet. There can only be one Configuration Manager active on the network.

How to install the Configuration Manager is described in its own (installation) manual. Find it
on http://help.esko.com/products/Configuration%20Manager.
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4.  Post-Install Configuration
Some configuration steps are done when first logging into the browser client. Others need to
happen on the DFE.

4.1.  Configuration when First Using the Browser Client

The Automation Engine installer creates a shortcut on the desktop. Start the QuickStart
browser client using this shortcut.

When starting the browser client the first time on a new system, you will be asked to decide
some easy configuration steps:

1. Create an administrator user

Note:  You will be able to create other users later, via the normal tool in the 'Admin' menu.

When done, login with that user and continue:

2. Configure a data container

A next page invites you to set the data container.

By default a data container called ‘ExampleJobContainer’ is used. This is a shared folder
created during the Automation Engine installation and is located on the same disk as where
the Automation Engine software was installed.

In case you want to use a different shared folder, select this shared folder from the drop-
down list. The default data container can always be changed (via the 'Admin' menu) but
already created products and production jobs will not be moved.

3. A next page asks you to configure presses and their resources. It refers to this document.
See the next pages.

4.2.  Digital Press Configuration and Migration of
Resources

4.2.1.  Connecting a Press driven by an Esko DFE (incl. HP L&P Print
Server)

Attention:  On this page, "Esko DFE" means a DFE made by Esko, including the "L&P
Print Server" as it is offered by HP Indigo.
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An Esko DFE already used color strategies, Dynamic Marks and step&repeat templates. In an
Automation Engine QuickStart setup, you need to make sure that these files are now visible
and controlled by the Automation Engine server:

1. Color Strategies

You need to redirect the color strategies on the Esko DFE to the AE server. You then also
need to copy these color strategy files from the DFE to the AE server.

a. On the Esko DFE, redirect the Color resources to Automation Engine

• On the Esko DFE, start up the DFE Configuration tool.
• Go to Start > Programs >  > Esko >  HP SmartStream Print Server  >  HP

SmartStream Configuration.

• Go to the Data tab.

• At the bottom, you will find ‘Resources search path’. Choose ‘Configure'

• Choose ‘On another computer’ and fill in the name of your Automation Engine
server.

• Click OK (2x).
b. Copy Color Strategies from a DFE (Esko DFE or Production Pro) to Automation

Engine.

To copy Color Strategies from a DFE to the AE server, proceed as follows:

a. STEP 1

• On the DFE or Production Pro, start Color Engine Pilot 13.4 or higher.

• Go to File >  Preferences >  > Database.

• Location of Color Engine Database : select “On remote computer”.

• Fill in the name of the DFE that you want to copy the color strategies from.

• Click OK.

• It might be required to restart the Color Engine Pilot at this point.

• Now go to the list of Color Strategies (Library >  Color Strategies).

• Select the Color Strategies you would like to copy.

• Once all the Strategies are selected, right-click "Export".

• Make sure the button “archive as one file” is switched on.

• Use the “Browse” button and choose a directory to export the .FP file to.

• Click “Export”.

This results in an .FP file (containing all your Color Strategies) on the selected location.
b. STEP 2
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Now import the Color Strategies on the Automation Engine:

• Open the Color Engine Pilot (on the Esko DFE or the HP Production Pro)

• Go to File > Preferences >  Database.

• Location of Color Engine Database: Select “On remote computer”.

• Fill in the name of the Automation Engine server that you want to copy the color
strategies to.

• Click OK.

• Go to File > Import and select the .FP file you created in step 1.

• Click on “Open”. All the exported color strategies are now listed in the “Import”
Window.

• Click “Import all” to import the color strategies.

The selected Color Strategies are now available on both the DFE and Automation
Engine and the Color Strategy Check can be used on these strategies. Learn about
this check in the eLearning module about Color Strategy.

2. Dynamic marks

Any dynamic mark sets present on the DFE must also be made available to the AE server.

Copy the dmk file in the bg_data_marks share on the DFE onto the same share on the
AE server (\\<dfeserver>\bg_data_marks_v010\DynamicMarks to \\<aeserver>
\bg_data_marks_v010\DynamicMarks ).

Note:  These mark sets can contain DFE variables. Learn which of those are supported in
'Can I still use my Dynamic Mark Sets that use Esko DFE variables? on page 38'.

3. SRT templates

SRT templates used by the DFE reside on the share \\<dfeserver>
\bg_data_custom_v010\powerlayout\DFE.

These SRT files have to be imported into the die database of the AE server. This is done by
using the tool in the browser menu Admin >  Dies (one by one).

Note:  In case you have a large number of SRT templates, bulk import of SRT files can be
done using the Pilot interface: copy the SRT files to the ExampleJobContainer of the AE
server and then run the task "Import Die" on these files. When you don't know the Pilot
interface, ask Esko support for help.

4. Add the DFE press to the AE QuickStart configuration
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In the browser client, add presses via Admin >  Presses. Learn more in the related eLearning
module.

4.2.2.  Connecting a Press driven by an HP Production Pro

1. Configuration of Color Strategies

The HP Production Pro should be configured to use the color resources from the AE server.
This requires an intervention of an HP service engineer.

In case you already created color strategies on the Production Pro, use the same procedure
as described above to copy strategies from the Production Pro to the AE server.

2. Add the HP Production Pro press to the AE QuickStart configuration

In the browser client, add presses via Admin >  Presses. Learn more in the related eLearning
module.

4.3.  Known Limitations

• In Dynamic Marks, DFE specific fields are not supported

When using DMK sets or SRT templates which contain dynamic marks, the DFE specific text-
fields are not supported in AE QuickStart.

• Non printing inks

When you add non-printing inks to the configuration of AE QuickStart (Admin >  System > 
Non-Printing Inks), you then also need to add these ink names to the list of technical inks
on the DFE (both when Esko DFE and when HP Production Pro). This is especially necessary
when you work with VDP jobs (both when pre-expanded or template based VDP jobs).
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5.  Details of the Product's Preparation
workflow

This page adds some details to the information mentioned in the eLearning module on the
Product Preparation Workflow.

5.1.  Preparation Workflow for Digital Printing

Preflight to Check EPM

This Pitstop preflight uses the profile 'HP EPM Basic Check.ppp'.

The product file will not be considered 'EPM ready' when the check finds any of these items:

• Text inside the trim box with a point size of 6 pt or lower.
• Lines inside the trim box with a stroke width of less than 1 pt.
• Filled objects inside the trim box that are smaller than 1 pt.
• Areas inside the media box with a total area coverage (TAC) of CMYK colors equal or higher

than 280%.
• black gradients or black images.
• rich black objects (fill or stroke with 100% K and C between 20% and 60%, M between 0%

and 60%, Y between 0% and 60%).

If the input file is a multipage file (a pre-expanded VDP file), then only the first page is checked.

Preflight to Check Objects

This Pitstop preflight uses the profile 'AEQS4L_Basic_Profile.ppp'. This profile is based on
the GWG profiles.

This is what this check does:

• It logs as an error:

• When it finds an empty crop box (GWG 2012 4.04).
• When blending color space is defined and is different from 'Device CMYK' (GWG 2012

4.26).
• When the color space of luminosity soft mask blending is different from 'Device CMYK' or

'Device Gray' (GWG 2012 4.26).
• When it finds an image (grayscale or color) with a resolution less or equal than 199 ppi

(GWG 2012 4.27).
• When it finds a 1-bit image with a resolution less or equal to 549 ppi.
• When the document is damaged.
• When the document uses any security.
• When the document is empty.
• When there is text inside the trim box that uses any fonts that are not embedded.
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• When the document contains annotations of the type 'Movie, sound and 3D',
'TrapNet', 'File Attachment', 'Screen' or 'Watermark'.

• It logs as a warning:

• When checking page rotation flags (GWG 2012 4.05) and it finds a rotation different from
0 degrees.

• When it finds text objects inside the trim box that use the font 'Courier' (GWG 2012 4.15).
• When it finds an image (grayscale or color) with a resolution less or equal than 239 ppi

(GWG 2012 4.27).
• When it finds a 1-bit image with a resolution less or equal than 799 ppi (GWG 2012 4.28).
• When the document contains any annotations of the type 'Text note', 'Markup' or

'Hyperlinks'.

The preflight report is saved in the product's 'Data Zone', in a subfolder 'Reports'. Learn more
about these folders in Where is Data Stored? on page 39.

Note:  The system keeps only 1 preflight report. When the prepare workflow is started multiple
times, this report is overwritten each time.

To-Do to Check the Preflight Report (if needed)

How the workflow continues depends on the result of the preflight:

• No warnings or errors: The workflow sets the product status to Preflight OK and continues
the workflow (if requested, by making the proof).

• Warnings and/or errors: The workflow sets the product status to Preflight Not OK and
starts the step 'Wait for Action (Checkpoint)', which shows up in the browser client as a
'To Do' item.

The user opens the To Do item and reads if the preflight resulted in warnings or errors. He
checks the report and then chooses to click on:

• Preflight OK. The workflow continues. The users decides that this product file is good
enough to produce.

• Preflight NOT OK. The workflow stops here. The user decides that this product file
needs to be changed, that a new PDF is needed.

Proof Report

Learn more about this proof in the page Customizing the Proof Report on page 32.

To-Do to Check the Proof (if needed)

After the workflow created the proof file (using the step 'ReportMaker'), it (again) starts a 'Wait
for Action (Checkpoint)' step, which shows up in the browser client as a 'To Do' item.

• The user can there check the proof file and then choose to click on:

• Proof OK. The workflow continues. The products status is set to 'Proof OK'. This means
that the proof PDF can now be sent to the customer to get their approval.
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• Proof NOT OK. The products status is set to 'Proof Not OK' and the workflow stops.

5.2.  Preparation Workflow for Flexo Printing

This preparation for flexo does not check for EPM. It does include a step to execute trapping.

Note:  The main workflow principles are described in the page Preparation Workflow for Digital
Printing on page 27. We here mainly illustrate the profiles that are used in the Preflight
steps.

Note:  When the public parameter 'Preflight' is set to 'YES', both the preflight steps are done.
Else, none of them is done.

Preflight to check the PDF file's integrity

The end status will be

• Preflight OK when there are no preflight errors (no messages or just warnings)
• Preflight Error when there are preflight errors.

The preflight report is named [file]_PreflightReport.pdf

This Pitstop preflight is done using the profile:
'MISINTEGRATION_CheckIncomingPDFIntegrity.ppp' (same profile as used in the standard MIS
integrations).

• This profile logs as an error:

• if the document contains embedded PostScript fragments (error)
• if the document contains pre-separated pages (error)
• if a page is empty (error)
• if there is more than 1 page (error)
• if fonts are not embedded (error)
• if OPI images are used (error)
• if the document contains JavaScript, actions or form fields (error)
• for an empty crop box (GWG 2012 4.04) (error)
• if blending color space is defined and is different from 'Device CMYK' (GWG 2012 4.26)

(error)
• if luminosity soft mask blending color space is different from 'Device CMYK' or 'Device

Gray' (GWG 2012 4.26) (error)
• This profile logs as a warning:

• if a page scaling factor is set (warning)
• for page rotation flags (GWG 2012 4.05), if rotation is different from 0 degrees (warning)

Preflight to check the printability (Flexo)

The end status will be

• Prepress Preflight OK when there are no preflight errors (no messages or just warnings)
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• Prepress Preflight Error when there are preflight errors.

The preflight report is named [file]_PrintingPreflightReport.pdf

This Pitstop preflight is done using the profile:
'MISINTEGRATION_CheckFlexoRequirements.ppp' (same profile as used in the standard MIS
integrations).

• This profile logs as an error:

• when a page is empty (error)
• when there is more than 1 page (error)
• when there are more than the maximum number of separations (public parameter)

(error)
• when it finds an empty crop box (GWG 2012 4.04) (error)
• when it finds overprint white text (GWG 2012 4.09) (error)
• when it finds overprint white paths (GWG 2012 4.10) (error)
• when it finds ambiguous spot colors (GWG 2012 4.21) (error)
• when ICC profile versions is higher than 2 (GWG 2012 4.24) (error)
• when classic delivery method (no (calibrated) RGB, ICC, LAB, calibrate gray based colors

(GWG 2012 4.25) otherwise logged as error
• when blending color space is defined and is different from 'Device CMYK' (GWG 2012

4.26) (error)
• when luminosity soft mask blending color space is different from 'Device CMYK' or

'Device Gray' (GWG 2012 4.26) (error)
• when it detects an image (grayscale and color) resolution less or equal than 199 ppi

(error). If resolution is less or equal than 239 ppi (GWG 2012 4.27) (warning)
• when it detects that the resolution of 1bit images is less or equal to 549 ppi (error). If

resolution is less or equal than 799 ppi (GWG 2012 4.28) (warning)
• when it detects single image page images with a resolution less then 450 ppi (error). If

resolution is less than 1200 ppi (GWG 2013 4.29) (warning)

• This profile logs as a warning:

• when it detects page rotation flags (GWG 2012 4.05) with a rotation is different from 0
degrees (warning)

• when it detects grayscale objects in overprint (GWG 2012 4.08)(warning)
• when it detects overprint 100% black text (GWG 2012 4.11) (warning)
• when it detects ink coverage inside the trim box that is higher than 320% (ignoring

objects smaller than 15mm) (warning)
• when it detects overprint 100% black text defined in deviceGray (GWG 2012 4.12)

(warning)

• when it detects overprint thin (stroke width < 2 pt) black lines (GWG 2012 4.13) (warning)

• when it detects overprint thin (stroke width < 2pt) black lines defined in deviceGray (GWG
2102 4.14) (warning)

• when it detects text objects inside the trim box which use the font 'Courier' (GWG 2012
4.15), if such text objects are found (warning)

• when it detects rich black text (K 85%, TAC 280%) is used (GWG 2012 4.16) (warning)
• when it detects small text (< 5 pt for 1 colorant, < 14 pt for multiple colorants) (GWG 2012

4.17) (warning)
• when it detects effective line width ( < 0.3 pt for 1 colorant, < 1.5 pt for multiple

colorants) (GWG 2012 4.18) (warning)
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• checks the spot color naming (GWG 2012 4.20) (warning)
• when it detects alternate layer configurations (optional content) (GWG 2012 4.30)

(warning).
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6.  Customization

6.1.  Customizing the Proof Report
The product preparation workflow allows to generate a proofing PDF file. Such a proof file
consists of a preview of the product with some technical information. It also contains a second
page showing the separations.

Note:  The language used in this template is the one you have selected as option in the tab
Prepare of that product.

You can change how that proof file looks by replacing some parts of the proof template file.
That template file is installed during the installation of Automation Engine.

How to change the Proof template

The PDF files for proofing are using a proofing template supplied by Esko (technically:
ReportMaker template). This template PDF refers to 3 separate PDF files that fill different areas
of this template.

These external PDF files reside on the folder

\\<Name-of-AE-Server>\ExampleJobContainer\Digital Label Production\Resources\ReportMaker
\Parts

These PDF files correspond to the areas numbered 1, 2 and 3 in the picture below:
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Simply replace each of these separate PDF files with your own content.

• Area 1 consists of ‘Header.pdf’. You could put your own company's logo here for example.
• Area 2 consists of ‘Disclaimer.pdf’. Your company probably has its own specific text that

you want your customers to sign off on.
• Area 3 consists of the PDF file representing the selected roll winding. There are 8 different

windings, represented by 8 PDF files ('Winding_1.pdf' to 'Winding_8.pdf'). You or your
customer might be used to a different style of these icons.

Attention:  When replacing any of these 3 Esko supplied PDF files by your own version,
make sure you respect the dimensions of the original PDF file. Otherwise they will no
longer nicely fit in the default template.

About the default proof template

This template resides on the folder

\\<name-of-AE-server>\ExampleJobContainer\Digital Label Production\Resources\ReportMaker\

This template should not be changed as it gets replaced by the default template that comes
with an Automation Engine installation after each update.

If a different template is required, skilled users or Esko staff can create one using Esko
PackEdge but it should be given a different name. They will also need to use the Automation
Engine Pilot to create a customized version of the 'prepare' workflow, so that it refers to that
new template.
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Units and Language

The unit used in the dimensions (artwork info & dimension lines) and the language of the
report are those as set in the Product's Settings > Tab 'Prepare' > Proof.

The proof template has all the language specific texts present in dedicated layers (1 per
language). The chosen language decides which layer is kept (during the workflow step
"Optimize PDF document").

6.2.  Customizing Workflows

Customizing a Product's Preparation Workflow

In the 'Prepare' tab you can save variants of the workflows that are offered by default.

When you want to customise a workflow further than that, this then needs to be done by Esko
staff, as a paid service.

For any such request, please contact Esko Solution Services.

Customizing a Production Job's Output Workflow

The production job types that have no live connection to a digital press, end in sending files to
another component.

In their tab 'Output' you select the matching 'output' workflow, which is by default a simple
copy of those files. And you there also specify their destination.

When you want to customise that output workflow, for example to have those PDF files also
RIP'ed and submitted to a DFS of an Esko CDI, then this also needs to be done by Esko staff, as
a paid service.

For any such request, please contact Esko Solution Services.

Note:  You may have purchased those services already together with the QuickStart
application. They this customisation may be done soon after the initial installation.

Note:  Output workflows that you created using the Pilot client, need a special tag to make
them appear in the browser interface of QuickStart:

• For the type 'Digital to PDF', the tag needs to contain QuickStart Digital Output.

• For the type 'Flexo to PDF', the tag needs to contain QuickStart Flexo Output.
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7.  Frequently Asked Questions

7.1.  Can I use the Browser Client from Outside my
Network?

No.

The (browser) client computer must be in the same LAN as the Automation Engine server.

7.2.  Which File Formats can I use for a Product?

You can create a Product from these file formats:

• *.PDF
• *.AI Adobe Illustrator when PDF compatible

Attention:  When you use the Esko plugin 'Borders' to set the PDF TrimBox/
MediaBox in Adobe Illustrator, Automation Engine will ignore these settings. To
make sure that these Trim Boxes / Media Boxes will be used, you need to export the
file to 'Normalized PDF'.

• Esko Normalized PDF when self-contained (no external images or other files).

7.3.  What about Multipage Files?

Can I use Multipage Files?

When you use a multipage PDF to make a product, the system automatically assumes that this
is file for a VDP workflow and decides that this product is a VDP product. A pop-up message
tells you so.

This means that, apart from that VDP case, you can not use multipage PDFs to make products.

Note:  In the Viewer, you can compare different pages of a multipage file. Learn about
comparing in this Viewer tool by checking the WebCenter Online Help (Complete Manual >
WebCenter Viewers > HTML5 Viewer > Compare Documents.

7.4.  Are there More Ways to use the Search Filter?
Yes. There are more advanced ways than those described in the eLearning modules.
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Important:  This page assumes that you have seen the parts 'Sorting and Filtering' in the
eLearning modules about the Products gallery and about the Production Jobs gallery.

We there show that you can type in a value and that you can select a category to restrict the
search to only that category. The selected category is then also added to the text in the search
field. And we show the example where we manually add a combination of categories and
values.

Rules and Possibilities when Typing in Filters yourself

We here repeat the main rules and add some extra possibilities and examples:

• In the search field, categories always need to be followed by a ' : '. For example: ' state:run 
'.

• When the name of a category contains spaces, you must put it in between quotes. For
example: "order material".

• Alternatively, some categories can also be written without spaces. For example: for "due
date", you can also write duedate .

• For "production job name", or "product name", you can even simply write name .
• To have an exact match with the word behind the category, you must place a ' = ' right after

the ' : '. For example: "production job name":=blond . This will find the job 'blond' but not
the job 'blond_2018'.

• You can type the name of a category in English or in its translated version.
• When the product or job setting contains 'word1' immediately followed by 'word2', you can

enter "word1 word2" or category:"word1 word2" .
• When these 2 words do not appear next to each other or are not even in a same category,

you can enter word1 word2 or category:word1 category:word2. For example: 60 fruitco
or name:60 customername:fruitco .

• When the category name is not recognized, it is treated as regular text.
• When you search for a word that ends with a ' : ', put it between quotes to avoid that it is

treated as a category.
• The search field is not case-sensitive.

More Ways to Filter on Date

As shown in the eLearning modules, you can filter on the creation date of products and on the
creation or due date of production jobs.

• What you enter in the search field must comply with one of these three formats:

• day, month and year
• day, month, year and time in minutes and seconds
• month

• The text of the date also depends on the language that you have chosen in User  > My
Preferences.

• Examples of supported dates:

• English:

• 08/28/2017
• 8/28/2017
• "August 28, 2017"
• "Aug 28, 2017"
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• "August 28, 2017 4:25 PM"
• "Aug 28, 2017 4:25 PM"
• "Monday, August 28, 2017 4:25 PM"
• "Mon, Aug 28, 2017 4:25 PM"
• August
• Aug

• French:

• 28/08/2017
• 28/8/2017
• "28 août 2017"
• "28 août 2017"
• "28 août 2017 16:46"
• "28 août 2017 16:46"
• "lundi 28 août 2017 16:46"
• "lun. 28 août 2017 16:46"
• août

• German:

• 28.08.2017
• 28.8.2017
• "28. August 2017"
• "28. Aug. 2017"
• "28. August 2017 16:48"
• "28. Aug. 2017 16:48"
• "Montag, 28. August 2017 16:48"
• "Mo., 28. Aug. 2017 16:48"
• August
• Aug.

• All date formats that contain spaces need to be put between quotes.
• Partial date formats are not accepted.
• Entering a date in one of the above formats without specifying a category will also search

for the date in all non-date settings of the product or job (as plain text).
• Next to dates, you can also use the words ' yesterday', 'today' and 'tomorrow'.
• When filtering based on a month, only products or jobs with a creation or due date within

that month of this year will be found.
• You can combine filtering on dates with filtering on other types of settings.

7.5.  Can I Print a Product that is 'Not Ready For
Production'?

Yes you can.

As explained in the eLearning module about Product Status, a product will be 'Ready for
Production' when it has its file been 'Approved'.

This product status is only information. You can still produce it. But when starting the
production job with this product, you will be asked if you are sure if you want to print it.
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7.6.  Can I still use my Dynamic Mark Sets that use Esko
DFE variables?

Summary

A dynamic mark set can contain dynamic text marks that refer to variables on the Esko DFE.

When launched from AE QuickStart, being added to the S&R task in the production workflow,
most of the DFE variables (press name, printing inks, color strategy...) are supported, with the
exception these:

• 'Screen name' is not supported. AE has no access to screening info.
• 'Substrate name, Printing Ink Names (long and short) and Color Strategy Name' are

only supported in case the Press Material or Color Strategy are explicitly selected in the UI
of QuickStart (not when only chosen as 'from Press Ticket').

• 'Step and repeat template name' is only supported with template dies, in which case it
will represent the name of the SRT file it was based on.

Table of DFE variables supported in a Dynamic Mark set selected in
QuickStart

CategoryField Info

DocumentFile name Comma separated list of the URLs of the input graphics. URLs can
contain hex-encoded (%XY) characters.

File date Modification date of the input graphic(s).

File time Modification time of the input graphic(s).

File date and
time

Modification date & time of the input graphic(s).

File Trim Box Trim Box of the input graphic(s).

File Media Box Media Box of the input graphic(s).

Color Input ink names List of ink definitions of the input graphics.

Input ink names
(short)

List of ink short definitions of the input graphics.

Printing ink
names

List of names of the printing inks (ink set + extra output inks). Only
works if color strategy was selected in the browser client of AE
QuickStart (not from the press ticket).

Printing ink
names (short)

List of names of the printing inks. Only works if color strategy was
selected in the browser client of AE QuickStart (not from the press
ticket).

Color strategy
name

Only works if the color strategy was selected in the browser client
of AE QuickStart (not from the press ticket).

Print
Job

Print job name Name of the production job in AE QuickStart.
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CategoryField Info

Print job date Generated by the S&R task (current date/time).

Print job time Generated by the S&R task (current date/time).

Print job date
and time

Generated by the S&R task (current date/time).

Press name Name of the selected press.

Substrate name Only works if the press medium was selected in QuickStart browser
(not from the press ticket).

Job comment Typically a message for the press operator.

SRT template
name

The name of the SRT template or the name of the numeric die. The
S&R task already has this parameter in its ticket.

7.7.  Can I Change the Proof Template?
Yes, you can.

This is described in the page Customizing the Proof Report on page 32.

7.8.  Can I Use Domain Users?

Yes you can.

You need to set this up on the Automation Engine server using Windows User Management
tools.

A domain user can be used when you add it to the Windows users group 'BGusers' or
'BGadmin'.

To see these domain users appear in the browser interface (Admin >  Users), just wait 15
minutes, or restart the 'bgmd' service.

Note:  Domain users with the same user name as the local user can exist.

7.9.  Where is Data Stored?
The interface of your browser client offers all the tools to access and view the relevant
production data. Below extra information is therefore for users that need a more advanced
knowledge of where this product and job data is stored. These are typically Esko staff or users
who were already familiar with the 'Pilot' client interface.
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Where is the Data stored of a Product?
• The files that you upload to create a product are stored on the Automation Engine server,

decided by a rule-based logic called the Smart Product Location.

Note:  For those that know the 'Pilot' client, this setup can be found at Pilot >  Configure > 
Products >  Smart Product Location.

• When no rules were configured in that tool, the product files are stored in the
'ExampleJobContainer'. This is a shared folder on the Automation Engine server that was
created automatically when Automation Engine was installed.

Product files are then stored according this file path:

\ExampleJobContainer\Products\<ProductCustomerID>\<ProductName>

This folder structure is created automatically when you upload a PDF file for that product
(for the first time).

Note:  If, for some reason, the folder 'ExampleJobContainer' does not exist, the files will be
stored in a randomly chosen shared folder (= 'Container'), following that same file path:

\<OtherSharedFolder>\Products\<ProductCustomerID>\<ProductName>

Note:  New products that were saved but for which no file was uploaded yet will not show a
product folder.

• This folder <ProductName> contains the PDF that you upload for this product. When
you upload other file(s) later on, they are also put there. Files with a same name will be
overwritten.

Subfolders are created automatically for each type of data:

• \Proofs: The proof PDF file is located here. When a preparation workflow is run more
than once, proof files will be overwritten.

• \Reports: The Preflight report PDF is located here. When a preparation workflow is run
more than once, preflight report files will also be overwritten.

• \Uploads: Product files for which a preparation workflow was started are copied here.
To make sure they are not overwritten, a prefix is added to their name with the date and
time you started the workflow.

Note:  The files in these 3 subfolders are visualized in the tab 'Data' of a product's settings.
The data categories match these folder names.

Note:  This product folder and its subfolders are also referred to as the Product Data Zone.

Attention:  When you use the browser interface to remove a product, users of the Pilot
client will notice that its complete Product Data Zone is deleted!

Where is the Data stored of a Production Job?

The data related to a production job is stored according the same logic as described above for
products.
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The moment a job is saved for the first time, a folder is created under

\ExampleJobContainer\Jobs\<ProductionJobName> 

(unless otherwise configured in the tool 'Smart Job Location').

Users of the Pilot client can see this folder as a blue 'Job'. The production workflow runs in this
job context.

All data created during the production workflow is stored in this folder, in a subfolder \temp.
Such 'temp' folders are hidden in the Pilot client, but they will be visualized when for example,
on one of the tasks in the workflow, you ask to 'Go to Output File'.

This folder contains:

• the Step&Repeat PDFs. One for each form of layout (<jobname>_sr_1.pdf etc..)

• the JDF file to communicate with the DFE (printrun_***.jdf)

• XML files describing the product PDFs (location, technical inks to ignore)
• PDF of each station (product PDF or empty station version of that product).

When you use the browser interface to remove a production job, users of the Pilot client will
see that the job is removed from the list of active jobs but that all its data are still kept (the blue
folder becomes yellow).

Where are the Dies stored?

In the browser interface, you can create a new die based on an SRT file. Learn more in the
eLearning module on Dies.

The system reads this file, adds the resulting die to its database, uploads the SRT file to the
server on :

\Esko\BG_DATA_CUSTOM_V010\powerlayout\ae

7.10.  Can I Remove an Order Material that is in Use in a
Job?

When you remove an order material, products that used that order material will from then on
have this setting on <none>.

The same thing happens for production jobs: this setting (which it gets from its products) also
changes to <none>. This is not a real problem as you can still start its production workflow.

Note:  Mind that the material that needs to be communicated to the DFE is not the order
material but the press material. The order material is only really used as a filter when adding
products to a job.

Follow these steps to get a different order material in a production job:

1. Update the products of that production job with another order material.
2. In the production job:

a. remove those product(s),
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b. then (re-)add those updated product(s) (and re-set the quantity and printing sequence).

7.11.  What happens when I make Changes to a Product
that is Used in a Production Job?

Can I change attributes of a Product that is used a Production Job?

Yes you can. However, the moment a product is added to a production job, its settings like
customer ID and order material are copied into that job. These values are not references.

Important:  This means that changing the order material and/or customer of a product
after the product has been added to a production job does not update the value of the order
material and/or the customer of a production job.

What happens if I Rename a Product After it was already Added to a
Production Job?

Renaming a product while it was added to one or more production jobs is not a problem.
The jobs can be produced successfully. The job has a reference to its products. It will pick the
products it was intended to use.

Attention:  When a print mark is asked to put the product name on the layout PDF, this
could be the old product's name (depending on the time the changes are made).
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